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This workshop contains an assortment of examples on parameters.

What is the purpose of this functionality?

Suppose that a SCIA Engineer user handles nearly every day with the same type of
structure.

Only the dimensions, cross-sections, height, number of spans, ... differs in the different
projects. For this, the option ‘Parameters’ can be used.

Every type -as mentioned above- can be parameterized.

The parameters are fully editable and when changed they may lead to a very
straightforward modification of the calculated model.

What's more, a model defined by means of parameters can be saved as a template.
When opened, the user is first asked to fill in the table with all the parameters present in
the model. This may be effectively used for creation of simple "programs" for e.g.
calculation of continuous beam, simple frame, etc.

The user has to create the structure only once. Then he/she has to define the
parameters and save the structure as template. In the future, he/she just fills in the table
with a few parameters and can immediately proceed to calculation and evaluation of
results.

This leads to a huge reduction of the working hours and will be more effective.

Above this, this workshop contains also some extra’s which can help the user to

become more effective in working with SCIA Engineer:

- XML: SCIA Engineer supports exporting and importing to/of this format.

- ODA: One dialog application

- Batch optimizer: The user can give a range of values to a parameter and the
solution is also a range of results.

- User blocks: A project can be saved as a user block. Afterwards, this block can be
imported in another project.

- Project templates: As mentioned before, the user can make a standard project
which can be used for all the other projects.
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Beam on two supports

A beam manufactured of C30/37 according to the EC-EN is supported on two ends.
We will input parameters for the length and the cross-section dimensions.

| 6000

¢ Project data: - Construction type: Frame XZ
- Project level advanced

=& Suppon

«  Input support: 4 innode

Method

¢ After activating the functionality parameters, you will see the function

- Tools Parameters

¢ The parameters get following properties with the values:
- LengthL:10m

- Width B: 300 mm

- Height H: 500 mm
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Next, go to:

[ L TR R

=32 Tools
ﬂf Line grids

5] Pararmeters

I Farameters termplate settings

=7 Loyers
B 1 lcar dofinad calartinne

Here the template tabs are made

[ Parameter set

RAiae Bkl o =& - |

= Parameters

Geomelry

Geomstry
Use 30 preview B

Infor

Picture

lcan

Femove (picture,

selected

[=N]:]
type

unit

BH

type

unit
BL

type

unit

New | Inser Delete

Subsequently you can use a new function:

Remark: the introduction of the picture will be explained later.

Froject

% Template dialogue

= Structure

Here the values of the various parameters can be adapted.
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fF Steel
TF Concrete
@ Document
«+ Bf Drawing Tools
= 8 Lbrary
B Materials
I Crass-sactions
B3 Catalogue blocks
# 8 Structure. Analysis
-6 Steel
@@ Concrste, reinforcement
@ subsoil foundation
# W Loads
@ Fire Heat
@ @ Heat Transfer
B2 Drawing Rule
=R Tools
#2 Line grids
Pararnsters

‘Pvnjedda‘a i

National cade
Structure
MNo.ofnodes
No.ofhsams
No.ofslabs

Mo. ofused profiles
Mo. ofload cases
Mo. ofused materials
Lostused annex

o by 7| |[P B 2 & R |

=llls m aunl =1 @l

D&H = B ? |[voorbeeld 1-ligger v || B & @ & QA ARXQ NP | &5 5| 2P BRERHE A RN KR E
00 %0 %o 0= 0F 40 06 1% 01 TR bR i) S = B B s mr B A mosgagnes e mun e Il e e 0
e AOLA S e
Project Gearmetry |
& Template dislogue
3 Stucture
L Load m J4o00
i+ L& Load cases, Combinafions H- [mm] 400.0
« [ CalculationMesh L-[m] 2500

Sample picture

Refresh

| OO

K ‘

Cancel

* The various parameters has to be attributed now to the cross-section and the length

of the beam.

- Length beam: X-coordinate of node K2:

Properties ﬁ
Node (1) ~|YV
MName | K2
E| GCS coordinate
Coord ¥ [rm] L |
Coord Z [rn] 0.000 E
E | UCS coordinate
Coord ux [m] 10.000
Coord uz [m] 0.000

= Members
hember

= Data
Supportin node
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- Width & height profile:

.D Cross-section

Mame C32 |A
Selectar switch [m] [
7 Type
Detailed
El Parameters
Material B15 I
H [rm] H =
B [mm] E Jiud
EII General 3
Draw colar MNormal colour _'j
Colout |
Properties editable [m]
Buckling editable E
Buckling y- L Jied
Buckling z-z b =
Fabrication | cancrete =
FEM analysis [m]
Curve dividing |16
Use reduction factors [m]
N Edit named iterms it
Editjoints L
Edit cuts it
El Property
& m" 2] |
B 400 Ay [m*2] |
[ Update I [ Document ]
‘ Picture |FibeS | [ ok I [ Cancel ]
¢ Changing a parameter:
The value of the length L is adjusted of 10m to 20m.
Bl Project K|
Geometrie |
- [mm] 300,0 AL
H- [mm] 500.0
| 20,000
£ v
}
g / \\
AR I
\ L4
[l
[ v ] =@ |
B
/ \ L
=l
4 1 v O
/ [ ox | concar | |
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If you use ‘Store users- default settings’, you can make various compositions which
you can load afterwards:

Project |Z
Geomstry |
8- [mm] 200.0 -~ Sample picture
H- [mm] 400.0
- fm] ] 20,00
& - i
'Parameters values ‘
‘Parametars value sets i
qroup 1
qroup 2
v
Refresh [—3
=
4 5‘ _|
¥y v Y
=
Delete I Select | Close
k| ] QLA 1 |

oK | Gancel | Keply
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Cross-sections

The same example will be used to explain the type of parameters for cross-sections.
For this ‘Cross-sections.esa’ can be used.

First of all the parameters for graphical cross-sections are explained. Next, the
parameter for the type of cross-section will be shown.

General cross-section

¢ If the user decides to work with a graphical cross-section, the method of
parameterizing is different from that of standard cross-sections.
¢ First of all parameters has to be created for the height en width of the cross-section.

5 Cross-section editor =
!.:Di All * Normal colour = | 88 m)| & ob T O L1§—EWJ@:U|£EKE|!|E¢@‘§'I@ R 2
|elaaaaam
— ’ I~
-[@ Polygon
@l Palygonal opening
-2 Thin walled
ﬁ Section fram libirary
- |F Dirmensian line
oot Iport Dk LG I Parameters
- P Parameter
-l Thirmwalled reprasentation e Be Al - &
- Add cut :
H1 Hame [E1
Bl | Type |Css length ;!
| Description
Evaluation |Walue ;!
| Walue [mm] |400.0
| Uss range O
r
pe (des General cross-
B General |
Buckling y=y c i
Hilcklingies = || Walidate = ]
Fabrication | general
Displayfinal shape B
Display Only basic shape _v_]
=
[ Refrash sex | 4] | bi
]CDmmand >
Ready. LN

« Next, the polygon can be introduced and after this, the parameters can be attributed
to the Y and Z coordinates:
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608 (s | %
[ an - Normal colour = | 3 ¢ | Be 5108 0| & o000 wox ikl | RS emEB R K E
& aaaaam
* o N
[P Palygan |
Bl Palygonal opening
-~ Thin walled
Bt Section from library
- |F Dimensian line
s |rport DXF f DWG
- P Parameter
- Thinwalled representation
i Add out
-
Coord¥[mm]  E1 | -]
Coord Z [mm] H | =
ETUCS coordinate | ; “_J
Coord uy [mm] | 400
Coord uz [mm] 200
= Cut
Murnber of cut
Marme of cut |MNone T J
Cuty i
CutZ [m]
-
< | 1
Command >

BN

Clase :

The difference with the parameters of a profile from a library is that here the parameters
can be made in the cross-section editor itself.

Above this, if the user wants to adapt these parameters, two parameters has to be
created in ‘Tools > Parameters’.
Here, we can create the same parameters H1 and B1:

- X
£ Al -
L - Length bearn MName Bl
B - Width strandard sec... | Type Css length R
H - Heigth standard sect.. | wiclht graph section
LC - Line Lc})_lad ey | Evalustion Value -~
B1- Wit graph secton || Y2l (1] 00
arap Use range o

Note:

It's very important that you give a good description to your parameters. On that way, it
simplifies afterwards the input and the adaptation of the parameters.
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These values can now be attributed to the properties of the profile:

[I:l Cross-section

Picture IFlbﬁ“

IName C53 |jh
Selectar switch [m] 1
Type Gieneral cross-section
Detailed 300: 400
B Parameters =
- H1-Heigth graph sectic =
| B1 -Width graph sectior = |
Edit E
=1 (“m—‘ 1 - -
Diraw colar Mormal colour -
Colour =
Froperies editable [m]
Buckling editable =
Buckling y-y [ ~
Buckling z-z c |
Fahrication general -
FEM analysis [m]
Curve dividing 36
Use reduction factors [m}
Editnamed items
Editjoints
El Property
A 2] 1.2000e-0M
Ay [m”2] 1,2000e-001 v |
[ Updets | [ Docurment |

Lo ]|

Cancel

]

To change these values, we can make a new tab in the ‘Parameters template
settings’ and this will appear now in the ‘Template dialogue’:

] Project

Geometrie  Graphical cross-section

400.0

300.0

H1 - Heigth graph section [mm]
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Type of Cross-sections

In SCIA Engineer it's also possible to parameterize libraries. Examples here are:
Materials, cross-sections, reinforcement, subsails, ...

In this topic, we will explain it for the type of cross-sections.
The other library types can be handled with the same principle.

Again, this will be explained by means of example ‘Cross-sections.esa’.

¢ Three cross-sections are inserted in the project:

CS1: RECT(400;400)
CS2: Graphical cross-section
CS3: CIRC (400)

* We define a ‘master’ cross-section. This cross-section is fictive and will be the

parameter. For this, we copy arbitrarily CS1 and we call it ‘Master’.
¢ For this master cross-section, the option ‘Selector Switch’ has to be checked and an

Alternative profile can be choosen now:
¢ Creation of the parameter:

O b 4
AL s BED o & B | - 7
C51 - RECT (400; 4007 Marme haster e
CS2 - General cross-sec.., Selector switch =
€53 - CIRC {400) Altemative | C51-RECT (400; 400) R
Master - RECT (400; 400) | 7, 1
Detailed
B Parameters
Matarial
H [rmrm]
B [mm]
B General
Diran colaor
Colour ]

Froperies editable

Close
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Without this option ‘selector switch’, we cannot use the parameter for the cross-section

type.

Go to ‘Tools > Parameters’ and the following parameter can be created:

[ Parameters

X

A ¢ BB oAl

L - Length beam MName =]
B - Width strandard sec... | Type Library |
H - Heigth standard sect... Description Cross-sections
LC - Line load . Liborany Cross-Sections |
H1 - Heigth graph section 1, Master - RECT (400; 400) -
B1 - Width graph section Altermative j
CS - Cross-sectons
Select Alternatives | J
Alternative no. 1
Alternative no. 2
Alternative no. 3
“alidate =
[ New |[ Edit || Delete |

Type: Library
Library: Cross-sections

Value: Here the fictive ‘master’ cross-section can be input.
Alternative: One of the 3 alternatives can be choosen. This alternative will be the

default profile.

Select Alternatives: The 3 alternatives can be inserted here

Attribute this parameter to the cross-section type of the beam. Pay attention: The
master profile becomes the parameter. But the content of this master will change
after choosing another alternative:

i it P A= I =
fF Steel
T Cancrete
(3 Document
@ & Drawing Tools
=B Library
=-3% Tools
#7 Line grids
Parameters
& Parameters template settings
& Layers
B User defined selections
@B ucs
B Cleaner
]1? Coordinates info
“f =ML 10 Docurnent
I3 Conver Steel Prafile Dh

Ta
2l
rember (1) ﬂ AT: T
MNarme =l »
Type general (0} Ei
nakysis model tandard -
| Master- RECT (400 400) = P | @] A ka2 ] 5| 2
P12 0 -
Member systerrrline at centre =
ez [mm] 0 hd B&| =0 e
LCS standard &
FER tupe standard hd

After creating a new tab in ‘Tools > Parameters Template settings’, it appeared in the
dialogue box of the ‘Template Dialogue’. And again, this box can be used to change

the cross-section type:
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||:l Project

‘Geometie | Graphical cross-section Type of CS |

25 - Cross-sections

[master - RECT (400,

X|

:S'ampleipi&tu re

Refres

Z

25| =] ]
CS51- RECT (400 4 Marne [E:2K] ~
C52 - Gererdl g Selector switch O il
Type CIRC A
Detailed 400 I
1| Parameters L
Material C30/37
Dfm] n
E| General
Draw color MNormal calour i
Colour |
Properies editable L]
Buckling editable |=
Buckling y-y |b @

0oy

oK |

Cancsl

| Apply

And this results into:
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Catalogue block

In this example a catalogue block will be inserted. After the introduction of it, it will be
parametrized.

¢ Project data: - Construction type: Frame XYZ
- Project level : advanced

¢ Goto ‘Structure > Advanced input > Catalogue blocks'.

= I Advanced Input
&F Catalogue blocks

The first block in the menu ‘Frame 2D’ is choosen. We keep the standard

configuration:
Geometry block

MName Blok

E Geometry o
L[] 10,000 Rd 2
H1 [m] 5,000 Rd pt
H2 [mn] 1,500 d o1
Kalom CS2-RECT (500; ~/... o
Staaf C53-RECT (500; 'I
2] o
]

L 10,000 =
= wy
pu —

s
- L
’TI Cancel
=2 Support

+  Input support: 4 innode
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Method:

¢ First of all, the parameters will be created. Go to ‘Tools > Parameters’:

=% Tools
#7 Line grids
Farameters
Farametars template settings

¢ The following properties are parameterized with a begin value of:
Span L:10 m

Height H1: 5m

Height H2: 1,5 m

Htot: H1 + H2

Middle: L/2

Rigidity support: 5*10°

o0k wnpE

[ Parameters

R. - Stiffness
Use range O

£ Al ™
Cwerspar - span | Crverzpan
H1 - first height Type
H2 - second height Description span
Htot - total height Evaluation Value .
Midder - X middle Value [m] 10,00
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[ Parameters

£ Al v
Overspan - span | Hiat
H1 - first height Type
HZ2 - second hgight Description total height
H_tot - total hqght Evaluation Formula
Mlddeh - ¥ middle Formula H1 + H?
R. - Stffiness
“Walue [m]
lse range O
() Parameters
£ All v
Cverspan - span [F
H1 - first height Type
H2 - second hgight Description Stiffness
'[:'qtg; - tOtjl h?:li?jTt Ewvaluation Value
idder -« middle
8.0000e-001
R - Stiffress Yalue [MM/m] =
Use range m}

*  When closing this window, the following question appears:

L o

. . T
Scia Engineer P

x_?() Wiould you like to check the correctness of the formulae?

fag Mo

Click ‘Yes' if formulae were used so they can be checked.
* Now the parameters are attributed to the various geometry-properties.

* Subsequently a line grid can be made:
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[Cime aridg)

Input dats. | Drawing setup |

Qv

%

~DirX[m] ~Dirz [m]
Type Span ~ Type Span ~
Name K[m] dx [im] Fep SL Name Z[m] dz [rm] Rep SL
T |A 0,000 0,000 a 1 = 0,000 0,000 a
2 |B 5.000 Midder = |1 a 2 b 5.000 H1 -fire = |1 a
i D 10.000 Midder = |1 a ic 6.500 HZ-se |1 a
* 0.000 oooo - a * a

Insertian point [m]
’7>< [n.ooo

v [0.000

0,000

Rotation

0,00

deg

Refresh names

Mame  |Raster] Type

Canesian  »

OK I Cancel

Apply |

¢ Theline grid can also obtain a parameter to adjust the view. This is possible
through a binary parameter with a Boolean value (yes/no).
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Plate on subsoil

¢ Project data: - Construction type: General XYZ
- Project level advanced

* Input support:
 =-Z Support
A innode
= point an beam
...... Z=Z |ine on beam

*  Input subregion:
' 5@ 20 member companents
4@ Subregion

¢ Load cases:

- LC1: Selfweight

- LC2: Permanent plane load q [KN/m”2]

- LC3: Free surface load on projected area: g [kKN/m”2]
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Method

¢ The following parameters are applied:
- LengthL:7m

- WidthB:3m

- Permanent plane load: 5 kN/m”2

- Free plane load : 2 kN/m”"2

- Thickness plate d: 200 mm

- Thickness subregion d1: 400 mm

¢ Adjusting the value of the free plane load:

qz [kN/m~2]
stante waarde -2.00

Fod

J Project

Geometrie plast  Belasting |

oA

@ - wlaklast [kMN/m™2] [-5.00
Q1 - wrije wlaklast [kN/m™2] -2.00
oA
I Project
Geametrie plaat Belasting |
- wlaklast [kM/m™ 2] -5.00
01 -wrije vlaklast [kMN/m™2] | -6.00
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Cellular beam

[ cross-section

m

Selectar switch
Type
Detailed
Farameters
Material

H ]

B [mm]

ta [mm]

& [mm]

ts [mm)

th [rmim]
General

Drawi color

Colour

| Propetties editable

Buckling editable

| Buekling y-y

Buckling z-z

| Fabrication

FEM analysis

| Curve dividing

Use reduction factors

| Editnamed itsms

Editjoints

5235

h - heigth of profile
b -width af profile

d1 -thickness flange
\d-thickness web
d? - inclination

|d2 - inclination

MNormal colour

|general
[

36

[

[m]
=
b
b
g

4
|« I'I‘I'I‘I'I‘L_

IR ENE]

4

v

| Picture |Fibres |

Project data: - Construction type: General XYZ

- Project level advanced

[

Update

) [aaen)

[

ok

Cancel

]

Input opening through: ‘Structure > 1D member > Modificator > Opening’.
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Method

The following parameters are attributed to the member:

[JParameters

[h

£ Al
h - heigth of profie
b - width of profie Type
d - thickness web Description
d1 - thickness flange Ewvaluation
dZ - inclination Value [mrm]
L - Length beam

se range

D - diameter borehole
¥ - positon first borebole
a - number of boreholes

Height profile h: 300 mm
Width profile b: 200 mm
Thickness web d: 12 mm
Thickness flange d1: 20 mm
fillet d2: 12 mm

Length member L: 6 m

Diameter bore hole D: 150 mm
Position first bore hole x: 0,15

Number of bore holes a: 6

Next, these items are attributed to the structure.

Subsequently the template settings and template dialog is made.

heigth of profile
Yalue

3000

[m}

. Project @
Prafile | Geamety beam | Sore holes |
B Sample picture -
d2 - inclination [ram] 12.0 [ar
d - thickness web [mm] 12.0
b -width of profile [mm] 2000
h - heigth of profile [mm] 300.0
1
d
az
b ‘
Refresh = &

Cancel
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Beam with practical reinforcement

It's also possible to parameterize the reinforcement. This will be shown in following example.

Project data:
- Construction type: Frame XZ
- Project level advanced

Input through:
== Model data

=2 Support
& innode

Load cases:
- LC1: Selfweight
- LC2: Variable load: g [KN/m]

=-[1 Redes (without As)
Input practical reinforcement: I MNew reinforcement
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Method

* Input of the following parameters with begin value:

- Height profile H: 400 mm

- Width profile B: 400 mm

- SpanlLl:3m

- SpanlL2:3m

- Total span Ltot: L1 + L2

- Variable line load Q: 15 kKN/m

- Reinforcement diameter above db: 12 mm

- Reinforcement diameter below do: 16 mm

- Reinforcement diameter stirrups dstirrup: 8 mm

Remark: the reinforcement diameters can only be parameterized when using the practical

reinforcement.
- Stirrup distance a: 0,3 m

»  Group parameters through:

= A& Tools
#F Line grids

| Parameters
Parameters template settings

In the dialogue box of the parameter template settings, pictures can be attributed from the

gallery:

[ Parameter set

A e & B Be| S = |al

Cross-secton
Geometry beam

R.einforcement

Load
MName Geametry beam
Use 30 preview &
Jrifig

Icon

B Parameters
B L1

You get the best resolution if you choose the following properties during saving:

- .wmf
- 550 x 550

¢ Check through Template dialogue
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] Project

Cross-section IGEDmetry beam] Heinfurcement] Load ]

[ 400,0
E -Width of section [rmm] 400.0

e Afterwards, the entire project can be saved as a template.
This by doing the following: save in the directory ‘Esa xx > Templates’

e The project can now be opened as a template and adjusted:

Select New Project

MNew Project Usertemplates

=11 Templates ’IT'V
(11 Connect
[ Steel beam with
practical rei...

ChDocuments and SettingsiAstrid SCIA-OMLINEW: Documents\ESABDtemplatesibearm with practical
reinforcement ESA

oK | Cancel

¢ After opening this template, a dialog box with the entered parameters appears. If
desired, particular properties can be adjusted here.
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[ Project (X

Cross-section lGeometry beaml Remforcememl Load | Froject settings

-~ Sample picture

H - Height of section [ram] 400.0
B -Width of section [mm] 400,00

Refresh EI El

K I Cancel Ay

2
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« Project data:

- Construction type: General XYZ
- Project level advanced

¢ Functionalities :
- Subsoill
- Soil loads
- Parameters

* Input support through:
- = Model data
- Z Support
2 innode
& line on 20 member edge
m surface (elfoundation) |

« Input geological profile and subsoil through:
=@ Subsoil, foundation

w Subsoils
& Geologic profiles

I subsoils

AeBEL | & @FsH| | v v
Subl | Sand/Clean/Loose
Sand/Clean/Loose Selector switch O
o [kMAm ™3] 1.0000e+002
Cly [kMN/m ™3] 1.00002+002
Clz Flexible Rd
Stiffness [kh/m™3] 1.0000e+004
T2 [kMAm) 0.0000e+000
[] Geologic profiles
A e ¢ B ol & == ™
GP1
Thickness = 2.00[m], Edef = 20.00[k}/m"2], Weight =
[iame  JaPt -
Selectar s, O [ Thickness =4.00[m], Edef = 25 00[k}/m"2], Weight =
“Water hei. |1.000
Mot compr.. B
B Layers
B1
Layer's .. B |
Thickne... 2,000 v
Mew || Insert Edit
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e Load cases: - Selfweight
- Water pressure
- Soil pressure

Method

e Parameter:
- Height bore hole profile h: -1 m, restriction between 0 m and -4 m

|: Parameters

£ Al v
h - ground level Marme h
B - subsoi Type
5 - geclogic profie | ground level
M- Materia_ls Ewaluation Yalue j
M1 - Materials Value [rr] .00
Use range &
B Range
Mimum Evaluation Value j
Minirnurn [rm) -4.00
Maximurm Evaluation Yalue j
hdaimum [m] 0.00

e Test of input data through:

{8 Syurface loads
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In this example the number of spans will be varied. This can be done by means of a
truc. The basic principle is: every beam belongs to a layer.

Above this a layer has two properties: Activity and Structural type (also Drawing model).

The principle is as follows:
A layer that is not active will not be displayed on the screen.
A layer that has the structural type will not be calculated.

This means that if you put a beam into a layer that is both non-active as in the structural
model, it will not be visible and above this, it will not be calculated.

On that way we can make parameters for the properties of the layers.
N

. Project data:
- Construction type: Frame XZ
- Project level advanced

. Functionalities - Parameters

== Model data

=& Support
. Input support through: A innode
Method
. The number of members is varied. This is done by means of Parameterizing the

activity and the type of model (analysis/structural)
. Input parameters:

1. Number of members N: 3
Remark:
The maximal number of beams is the number of beams that had been introduced in
the project.

2. Activity of the layers : > Boolean
- L1:formula N>=1
- L2:formula N>=2
- L3:formula N>=3
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3. Model type of the layers: >Boolean

- C1: formula not(L1)
- C2:formula not (L2)
- C3:formula not (L3)

Example:

N=2:

= L1andL2:true, L3 is false
= C1 and C2: false, C3is true
This means that Layer 1 and 2 are visible and not in the structural model.

Layer 3 will not be displayed and will be in the drawing model (not in the analysis

model).

[ Parameters

A £ B All

M - Number of beams
L1-Actviby 1

L2 - Activiby 2

L3 - Actvity 3
C1-CAD
C2-CADZ
C3-CADS

N

] Layers

MName I
Type

Ewvaluation Yalue
Yalue 2
lse range O

Grouping the parameters through: Tools > Parameters template settings

Subsequently a parameter is attributed to the various layers:

| Mumber of beams

2 38 e B

Laagl
Laag2
Laag3

= & |

L1 - Actvwity 1
L2 - Activity 2
L3 - Activity 3

| Laag
Comment
Colour
Structural rodel only C1-CAaD j
Current used activity L1 - Activity 1 |
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¢ Variation number of member through the template dialogue

¢ Use the activity toggle

T ER

[JProject m
Aantal staven
M - Murnber of beams |2 —Sample picture
Fiefresh | ilil
[
™~
S2/Laag2 83/Laag3
= AN JANS
[
4 _’IWW%
’TI Cancel | Anply |
A
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This gives as result:
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Steel hall

In this example, the number of spans will be parameterized. The same principle with the
layers as in the previous example will be used.

. Project data:
Construction type: Frame XYZ
Project level advanced

. Functionalities - Parameters

. Input support through: Support > nodal support.

. Input catalogue block with parameters H1, H2 and L
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Geometry block ﬁ
Marne Blok
E Geometry

L[m] L-Length &
H1 [m] H1 -Heigth 1 -
H2 [m] Hz - Heigth 2 -
Kalam C33-HEAZ40 ™ | oo
Staat CS2 -IPE200 |
o
T =

L 10,000 =1
_ -
- —

jan
[0]:4 Cancel
Method

e The number of frames is varied, ranging from 1 up to and including 7, through the

binary parameters for the model type and the activity.

¢ Applying the following parameters:

(o]

O O0OO0OO0OO0OO0OO0O0OOo

Height H1: 5m

Height H2: 1,5 m

Total Height Htot: H1 + H2

Length L: 10 m

Number of frames NS: 7

Frame distance S: 5 m

Frame distance 1 t/m 5 (S1/5): S*1 ... S*5

Total frame distance S6: S*(NS-1)

Activity layers B1 t/m B7: NS >=1 .. NS>=7

Construction model layers Al t/m A7: not (B1) ... not (B7)

At which the following parameter types are used:

(o]
(o]
(o]

Height, length and frame distance : length
Number of frames: integer
Activity and type of model layers: boolean
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Now the parameters can be attributed to the properties of the model:

Layers
] Layers ﬁ
=N vl
Layer1 B1- activity 1 | Layer?
Layer2 B2 - activity 2 Comment
Layer3 B3 - activity 3 Colour
tayerg gg - acgv?g g Structural model anly Af - CADG =l
aver - activi i i
I t d act BY - activity 7 h
Laver6 B6 - acti'\.-'lty & Lrrent used 4 |\v"|ty ty —
Lawer? BY - actvity 7

Geometry properties of the catalogue block

Coordinate Y of the nodes of the model: parameter frame distance
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Plate with ribs

Two types of parameterized plate with ribs are shown here. The previous principle of
the properties of the layers is used here.

Plate with ribs_1.esa

* In the first case the number of ribs is dependent on the width of the plate. The offset
of the ribs and the distance between several ribs remains the same in each case.

¢ To obtain this, we divide the plate into several parts. The number of the parts is equal
to the maximal number of ribs.

¢ Inthis case we the maximal number of ribs is 6.
So, a parameter N with type ‘integer’ is made with standard value 6.

¢ Other parameters are:
Al...A6: Boolean
Formula: N>=1...6

C1...C6: Boolean
Formula: not(Al...A6)

e Afterwards, these parameters can be attributed to the properties of the 6 created
layers:
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] Layers m

A e@Euin& el 7
Laagl A1-0 Mame |Laag B
Laag_2 AZ2-0 Cormment
Laag_3 AS-0 Colaur
Laag_4 Ad-0 Structural model onky CE-0 hd
t::g:g ig - 8 Current usad activity AR -0 hd

The plate with the connected rib can now be input in the respective layer.
In the ‘view parameters for all’ , the colour can be set on ‘colour by layer’.
This is practical to verify if each rib is in the correct layer:
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e After creating a group in the ‘parameters template settings’, the number of ribs can be
adapted in the Template dialogue:

] Project

FParamSet |

M - | 4
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Plate with ribs_2.esa

In this case, the offset between the outer ribs and the end of the plate remain constant.

The distance between the inner ribs is always regular.
This is shown in the understanding example.

Originally, a plate with 5 ribs is created. Afterwards, the ribs are input in layers and the
x-coordinates are parameterized.

First of al the parameter for the number of ribs is created:
This can be an integer value between the range of 2 to 5.

-
£ Al v

¥ - offset first beam MName M
B - width plate Type
%1 -B-x Diescription
M Exaluation Yalue j
Al
4o Yalue 2
A7 Usze range B
Ad B Range
A Mirnurm Evaluation Yalue j
1 Minimurn |2
C2 kaximurn Evaluation Yalue j
C3 kaxirmurm ]
c4
ch5

R

The offset coordinates of the outer ribs are:
x for the first ribs
B- x for the last rib, with B the parameter for the width of the plate

The 3 inner ribs get the following coordinates:
X2 = x+((B-2x)/(N-1))

x3 = x2+((B-2x)/(N-1))

x4 = x3+((B-2x)/(N-1))

As in the previous examples, parameters A1..A5 and C1..C5 are created for the
properties of the layers
To finish this, the ribs are attributed to the correct layers.
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«  When changing the number N in the template dialogue, we get the following results:
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Tubular plates

. Project data:
- Construction type: General XYZ
- Project level advanced

. Functionalities — Parameters
. Input channels as ribs: Plate rib
Method

e The principle is as follows:
The plate is divided into different subplates. The reason for this is if the plate will
shorten, also a rib will disappear. By making different little plates, this can be solved.
¢ Making the parameters that determine the geometry properties of the plate and rib:
- width profile b: 1480 mm
- height profile h: 1100 mm
- height upper flange h1: 250 mm
- height lower flange h2: 160 mm
- thickness web t: 140 mm
- thickness plate d: =hl
- length partial panel: =b
- angle of fillet plate alpha: 30°
- total length plate Ltot: 12 m
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These parameters are attributed to the channel

mwmmfﬂm'

tha 140
A 1480

thb2 160

B 1100

[Pimure |FibeS |

| Name C52 l"'
| Selector switch o [
Type Oy
| Detailed (7480 1401100, 260 160 |
B Porameters | |
Malerial cieas e
Al o -idhisection: B
tha [mm] t-thickness weh Zll =
Blmm) h-heigh secton |
thi1 [mm] h1-heigth upper flange - |
tthV[mm] h2-heightlowerflange |
o | e TR W TREe |
Draw color MNarmal colour _j
|Colowr |
|Propetlies editable O B
Buckling editahle a8 |
| Buckling -y b [=
Buckling z-z b =
| Fehrication genersl =
FEM analysis a
| Curve dividing |38
Use reduction factars a
| Editnamed tems o
Editjoints s
| Edit cuts Al IV
[ Updlsate ] [ Document ]
Lo ] [ cecel ]

Input of 1 plate (as an element of the whole plate)
Input of the plate rib with effective width b

Use of dummy members, e.g. circular profile with diameter 5mm so the rib and

member can be connected by a common node.

Without these dummy beams, the ribs will not follow the plate after changing the
dimensions of the plate.

Connect nodes/edges to members!

+4
= =
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¢ Input other plates through “more copies”:

-+

0o

‘Malticopy 4

Mumber of copies I 5 Connectselected nodes r
: with new beams
[v Insertthe very last copy Copy additional data 2
— Distance wectar How to define the distance ¢
Define distance by cursar [v (® hetween two copies
» IIZI,EIEIIZI - (" from original to the last copy
—How ta define the rotation ?
Y IEI,EIEIIZI Tl .
(@ between two copies
£ ID'DDD M (" from original to the last copy
— Fuotatian Fuotation around
- 0.00 deg (& current UCS
(" distance vector
Py 0.oo deq
rz 0,00 deg K Cancel

* An angle alpha of 30° is entered as parameter. With this, the x- and y-coordinates of
the vertices of the partial plates can be entered:
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Example:

Partial plate 6:

- x-coordinate x6: = b*6
- y-coordinate y6a: tg (alpha) * x6
- y-coordinate y6b: tg(alpha)*x6+ Ltot

x6,y0b

=

This way, an inclined plate is obtained.

Adjusting the number of partial plates/ribs:

- Parameter for the number of parts: N (< = 10)
- Parameter L1..10: They determine the activity of the various layers

Vb. L6: boolean with formula N>=6
- Parameter C1..10: they determine the type of model of the various layers

Vb. C6: boolean with formula not(L6)

Making the different parameter template and adjusting the number of parts to e.g. 6
through the template dialog:

47
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Geaormetry tibs Numberufribsl

- Analysis model:

- Structural model
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E

|

Il Knoopondersteuning

MNaarn |Sn13
Type | Standaard j
Hoek [deg]
* Wast -
Rz e Ivast z
Z _\/erend =1
z Stijffheid 2 [MMNfm] Fi-inyrichting =
X \ P Wast =1
&« R Py Wast R
Ei/ @\y Rz _Vast =1
Standaard afm. [m] |0.200
B Geometrie |
IZ Systeern GCS |
&
oK | Annuleren
/x|
Supportin node (1) j AT
ENE
Type standard j
Angle [deg]
X Rigid I
v Rigid I
z Flexible e
Stiffness Z [MN/m] F.-inyrichting I
Fix Rigicd I
Py Rigicd I
Rz Rigicd I
Default size [m] 0.200
Made
B Geometry
System GCS j
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Hollow core slab

A practical use of parameters is in the case of hollow core slabs.
In this example several functionalities are applied:

- prestress
- building stages
- TDA

- Parameters

eyl

. Project data:
Construction type: Frame XZ
Project level advanced

. Functionalities

— Parameters

— Concrete: fire resistance

— Prestress:

Advanced
Hollow core slab

. Model: Construction stages
. Span: 6.2 m
. Material type: concrete C25/30

¢ The hollow core slab is entered by means of a dwg
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Method

1. Entering a cross-section

The outline and the opening are selected alternately, after which they can be imported

through ‘import selection'.

[ Import selected

limport - D:\Scia.Esa PT\Projecten Per theorie\Opleidingen\Echo\woorbeeld10-hollow core slab.dwg
i Layers i Entity types i [ Selection mode -
.U .@_BEDC.‘K |PDIyg0naI openings LJ Clear selection
¥ DEFPOINTS vl Circle I | Ir
VIWO-MTL vl Line
M Text Scale ﬁ— Cancel |
viFaline e
T 7045360
i~ Connectsingle curves to closed polygons -
Enable all Disahle all Enable all Disable all Select curves
L] L]
1= ® O ® O @ O @ O =]
1 I e

2. Inserting the prestressed tendons

Subsequently the prestressed tendons are entered:

Go to the concrete menu > Prestress — strand pattern:

2 regions are now made for the bore hole pattern.

M= X
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Bore hole pattern

X]

DS

Pegions | Holes |

Fegiol Addd
Fegio?

Delete

Hole diameter fmm] 10

Region

Name Regiol
Leftbotomy [mm] 0

Lett battom z [rmim] 0
Widhh [mm] 600
Height [mm] 150
Type Increment |
Firsthale y [mm)] 50
Firsthals ¢ [mm] 20

Dy [mm] 100

Dz [mm] 100

[Reference point

¥ [mm] 299
2 [rmm] ]

COrigin of coordinate system Left botiom of outline of c-s | Import DWG OK Caneel
Bore hole pattern a
Fiegions | Holes |
Fegiol Add
Regio?
Delete
[Region
Regio?

Lettbotomy mm] 0
Leftbotiom zmm] 0

N Width [mm] 800
Height [mm] 150

SR Type Increment Bl
— Fitsthole y [mrmi] 140

Firsthole z [mm] 130
Dy [mim] 320
Dz frrm] 100
Hole diometer [mm] 10
Reference paint
¥ [mrm] 798
2 [ram] ]

Origin of coardinate systerm Left bottom of cutline of c-s =] Import DWG oK Cancel
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The initial stress of the prestressed tendons is 1250 Mpa.

3. Inserting the supports

- point load on node, at begin and end node of the member
- point load on member: on0,07 and 6,13 m
- point load on member: on 0,8 and 5,4 m

4. Making the load cases

A eBEI 9 & SH Al - ¥
stage 1 Mame stage 7
stage 1b Description
stage 2 Action type Fermanent
Sttzgei LoadGroup LG hutl I
stage
Load Standard -
stage 5 nad bpe
stage &
stage Ga
- Selfweight member

- Prestress 1250 Mpa

- Stage 2: empty (permanent)

- Stage 3: empty (permanent)

- Stage 4: line load on member 0,6 kN/m (permanent)
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- Stage 5: line load on member 1,2 kKN/m (permanent)
- Stage 6: line load on member 1,2 kN/m (variable — long term)

- Stage 7: empty (permanent)

5. Inserting the construction stages

] Construction stages setup

=] Time analysis
= Load factors
E Permanent (long-term) load case

Gamma min [-] 0.00
Gamma max [] 1.00
B Prestressed load cases
Gamma min [-] 0.00 =
Gamma max [] 1.00
= Long-term part of variable load
Factor Psi[-] 0.30
= TDA
E Load factors for generated loadcases
gamma-creep min [-] 1.00
gamma-creep max [-] 1.00
E Time - History
MNumber of subintervals 1.0
Ambient moisture [$4] 70.00
Automatic calculation of subintervals O no
B Local time axis [v
T £ b 1 00
oK Cancel ‘
Stage 1

Prestress and selfweight of the member

Load cases: presstress + selfweight
Time: day 1
Relative humidity: 100%

Stage 2
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Transport

Load cases: empty
Time: day 1,1
Relative humidity: 100%

Stage 3
Storage

Load cases: empty 2
Time: day 1,2
Relative humidity: 70%

Stage 4
In situ, placing the plate

Load cases: q wall 0,6 KN/m
Time: day 28
Relative humidity: 70%

Stage 5
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Casting of the coating

Load cases: 1.2 KN/m
Time: day 50
Relative humidity: 70%

[CJ Construction stages

X

A2k 9 & u ] ¥
5T1 Mame |sT8
=72 Order of stage
ST3 Description
=S4 Global time [day] T5-fase § |
=TS MNumber of subintersals 1
< Last construction stage B
B To
Load case fase b ..
Garmma min [-] 0.00
Garnma max [-] 1.00
Bl Load case prestress
Load case Mone j_l
Type of generated combinations Code independent j
“ariahle load cases e

1= [ Ingert “ Edit ” Delete ]

[Cose )|

Stage 6
Service

Load cases: long termVar 1.2 kN/m - will be used as long term load. Here it is

important to pay attention to the duration of the load case, sc 'long'.

Time: day 100
Relative humidity: 70%
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Stage 7
After 50 years

Loads

Load cases: empty3
Time: day 18000
Relative humidity: 70%

6. Inserting the parameters

- Length hollow core slab:
Type: length

Evaluation: value: 5,25 m

- Height hollow core slab:
Type: cross-section length

Evaluation: value: 150 mm

- Location support on member:
Type: length
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Evaluation: formula: resp. Length member — 0,07 and length member — 0,8

- Parameters general cross-section:
Type: cross-section length
Evaluation: value

(examples: width to first opening, width opening, width between the openings,...)

- Initial stress:
Type: stress

Evaluation: 1200 Mpa

& 1770C-6,0-
& v1E70C6.5
® V1670C-7.04
O RINC-7 R
< >

oo o o

Strengeigenschap l Geomet[iel

\T&

Maam Streng®
Id a
Groep

I ateriaal YIEFOC- ..,

Pasitie ingat | Centrum j

azt O
Onthechtings... Geen 4
g Yolgorde wan... | 1 hd
. Manier van v... | Type 3+,

0 =pi - initiele ¢ -
zetting [.. | £.00
Werarkerings... | 1.00
Afgtand tugs... | 0.500
Bl Positie
** [m]
Z [mm]

Canectiespa... | spi - initiele s |
< Duur van Cor,.. | 300,00

Ll
-

- Anchorage length:
Type: length
Value: 1m
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@ 1770C-6.04 a
& vY1E70C-E.9- a
& ‘1E70C-7.0 a
D YIRINN-7 Rl n A7
O : °
Strengeigenschap l Geometrie]
\TE
Maam Strengd
Id g
Groep
b4 ateriaal Y1E70C- « ..,
Positie ingat | Centum |
Wast [m}
Onthechtings... Gesh hd
g Wolgorde van... | 1 hd
. Manier vany.. | Type 3+,

Corectiespa... | #pi - initiele s_ |
< | Elaai pi - initiele s

Werarkerings... | 1,00 hd
Afstand tusz... | 0500
B Positie
' [m]
Z [rann]
- Lineloads:
Type: line load
Value:
- wall: -0,5 kN/m
- casting coating: -1,75 kN/m
- long term var: -1,75 KN/m
- Time of prestressing
Type: time (history)
Value: 1 day
[J Construction stages
EREL I 4 Co el JIFNT v
5T1 [=T1
=72 Order of stage
573 Description
=4 Global time [day] T1 -time of stressing -
ig MNumber of subintervat 1
T Ambient humidity R - stage 1 |
Last construction stage O
B Load case permanent or long-te...
Load case fase 1h 7] |ong
Garnrna min [-] 0.00
Garmma max [-] 1.00
B Load case prestress
Load case fase 1

Type of generated combinations Code independent

N
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- T2upto andincluding T7:

Type: time (history)
Value: 1,1; 1,2; 28; 50; 100; 18000

- Relative humidity
Type: relative humidity:
Value: 70 and 100%

- Cross-section type
Type: library

Method: make a ‘master’ cross-section (copy of the original cross-section) and use the
option ‘possible alternative’.

Subsequently it can be used with parameters as follows:

|cs
Type
Description section
Librany Crozs-Sections it
“alue master - General cross-section d
Alternative C52 - Grafische doorsnede |~

Select Alternatives
Alternative no. 1
Alternative no. 2
Alternative no. 3

Alternative no. 4

- Strand pattern
Type: library

Method: idem as the cross-section type. Make various strand patterns and copy a type as
a master case.

|BGP
Type
Description bare hole pattern
Library sectional strand pattern 1=
“alue master |
Alternative SaP el

Select Alternatives
Alternatiee no. 1

Alternatiee no. 2
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Analogous possibilities for the type of library are: materials, stressing beds, bore hole
patterns, ...

Other possibilities to parameterize:
Moment of casting, Moment of releasing the casting

7. Making openings in de hollow core slab

Two openings are made, of which a number of values are parameterized, sc:

- deltax:
Type: length
Value: 1m

- Width, length and depth opening:
Type: cross-section length
Value: 500 and 150 mm

- Xx_offset:
Type: cross-section length
Formula: -width/2

- x_hole:
Type: length
Value: 2,1 m
- n_hole:
Type: integer
Value: 2
I Member1D opening
MName Okl -~
Shape Rectangular =l
B Rectangular
B [rm] haole_w - length j
H[mm] haole_w- length j
Alpha[deg] 0.00
B Position yfz
Alignment Top j
Ferp.offset [mm] p_offset- perpendicular offset j
Orientation z =l
Beta [deg) 0.00
Depth Fartial j
Depth walue [mm] hole_h - depth j
B| Calculation
Use for analysis and design O no
Mumnber of FE 4.0 =
Member
B Geometry
Positionx[.m.]. »_hale - location of opening jl-v-
) ol b - -
ok Cancel |
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8. Using the template dialog

Subsequently these parameters can be divided and the template dialog can be used:

staafopening ! algemene duursnedel fases I.geumetne | Belastingsgevallen | strengenpatroon |

— Garnple picture

hole_h - depth [mm] [150_,0
hale_| - length [mm] 54DD,D
hale_Iz - length [mm] 1400.0
hole_I3 - length [mm] 4000
hale_w - length [mm] 1400.0
x.__dis.t.— dehax.[.m]. i :1,Dﬂ
| »_hole -|ocation of opening [m] 200
n_hole - number 12

Fefresh | il EI

[

P
1
[

Ok I Cancel Al

A

9. Different number of spans

Now the number of spans can be adjusted by means of copying the hollow core slab
and to divide it into layers. For example: 3 elements.
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Subsequently the following parameters can be used:

- N: number of spans
Type: integer
Value: 3

- Activities of the various layers:

Type: boolean
Evaluation: formula
Al: N>=1
A2: N>=2
A3: N>=3

- Construction type of the various layers:

Type: boolean
Evaluation: formula
C1: not(Al)
C2: not(A2)
C3: not(A3)

63
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XML

SCIA Engineer allows for the exchange of data with third-party applications through the
popular and powerful XML format. Moreover, XML format can be used to develop tailor-
made applications that use SCIA Engineer as a "hidden" engine working on the
background and performing calculations of company-specific problems.

The XML file editor is very similar to the Document of SCIA Engineer. The principle is
that the user defines tables describing individual entities of the SCIA Engineer projects
and there order. This table-form can be easily previewed (it is in fact identical to the
standard SCIA Engineer document). When ready, the final XML file contents can be
transformed into the real XML format through the export function.

® Take example 8 again: steel frame.esa

If’ Coordinates info
i #WL 1D Docurment
Through | R Tools X3 Convert Steel Profile Db

.D XML Input / Qutput Decument - @@
DOC-Defal ] ] BS|| 15D W7 e [ | B[P deraut [l
= 4 Default —|
[ parameters 1. Parameters 1
Name UniquelD Type | Evaluatic
H1 {5A0826EE-1820-4458-9086-31781F326D32} Length |Value
H2 {B4D32D70-36E7-4512-B1D1-A7193ADD5A 18} Length |[Value
Htot {9472EB82-54C7-4D48-AE09-E570F4D24E66} Length Formula
- = L {676B5CB5-B211-44F2-B74B-3C965301B56A} Length |Value
L Earameters
Caption EBarameters
Wisible yes L]
Prefer ane page [a] NS {8E25ED26-1A55-4CF6-8BD4-5353B39CABF1} Integer |Value
Filter All j
S {4A3FD994-A184-40F7-A7A0-D97607CA2ACE} Length |[Value
S1 {DCFO03F45-0036-49A9-AB9E-24D07 23A0605} Length Formula
52 {3A20EBF8-F846-42E7-A9FE-7894DA6257D9} Length Formula
Refresh o> | | B Ready [en] (&) &l v
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e Export to XML:

- <obj id="4" nm="L">
<p0 v="L" />
<pl v="{676B5CB5-B211-44F2-B74B-3C965301B56A}" />
<p2 v="3" t="Length" />
<p3 v="0" t="Value" />

<p5wv="0" />
<p6 v="Length" />
- <p7 t="">
- <h>
<h0 t="Real" />
</h>

Zfow id="0">
<p0 Vzlfiolf f>

oW
</p7>
- <p8 t="">

- <h>

<h0 t="R&jl" />
</h>

* Adjusting the parameter L: 10 > 20
Remark:
For this purpose, it's necessary that the XML-document is opened in a text-file, for
example: notepad.

<obi id="4" nm=""L">»
<p0 w="L"/>
<pl v="{67BBSCEB5-B211-44F2-B74E-3C965301B56A1" />
<p2 w="3" t="Length" />
<p3 w="0" t="value"/>

<ph w="0"/>

<pb wv="Length" />
{p? t:“”}

<>

<0 t="Real "/>

<pB t=""=

<h>

<h0 t="Real " /=
</h

<o Jd="0">

<p0 w="-1000000" /=
</ PO

</pEx>

* Regenerate the project through ‘File > Update > XML file'. You will see that the
structure has been changed now.
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ODA

Oda is the abbreviation of ‘One dialog application’. It's also called the SCIA engineer

Template.

It can be used for following type of projects:

Choose type of new project

B = E+= ==
=H == =
Concrete Beam - Concrete Bearmn - Concrete Slab
Standard Advanced

e
"

Zeman

T W

Farametric Batch optimizer
Froject

Farametric Project

Cancel

In this workshop the options ‘Parametric project’ and ‘Batch optimizer’ will be used.

The Batch optimizer will be explained in the next example.

The main principle of ODA is as follows:

- In SCIA Engineer a project is made, eventually with parameters and with document,

and saved as a template.

- After this, SCIA Engineer has to be closed. It's not possible to open the same project

in ODA and in SCIA Engineer at the same time.

- Now, ODA can be opened and the user has to choose the type of project.

- Inthe most used case ‘parametric project’, the user can change the value of the
parameters and the result is a document with all the added tables.

- This is shown in the following model.
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Project data:
Construction type: General XYZ
Project level advanced
Material: concrete C20/25

Functionalities — Parameters

Load cases:
- Selfweight
- Variable line load: 1 kN/m

Combinations: UGT and BGT
Document input:

- Nodes

- Load cases

- Combinations

- Internal forces: My

- Deformations: uz

Parameters:
- Diameter cross-section: 200 mm
- Thickness cross-section: 5mm

Method

e Save this project, e.g. Oda.Esa, in the folder ‘Templates’ and close (if this is not
performed, a conflict will arise when opening ODA).
¢ then open the program SCIA ODA:

¢ The following dialog box appears:
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Choose type of new project m
g = B+= == B -
L2 =2 =2 § |
Concrete Beam - Concrete Beam-  Concrete Slab tixBeam Farametric Batch optimizer
Standard Adbvanced Froject
554 tnn
T

Fernan

Concrete Beam - Standard
Cancel |

Choose the option ‘Parametric project’.

¢ The following dialogue box appears:

Select New Project

User Templates |

= Templates T M
-3 Connect r r
------ 3 Steel bearn with ODA

practical rei...

oK Cancel
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Now the various steps can be re-run and possibly adjusted:

W scia Engineer Template - ODA

|| e Edit View Setup Help

[DSE o= 82

|mEan

Commands ﬂﬂ

Project settings

Geometry
Ly

Document

O - diameter [mim]

200.0

t-dikte [mm]

5.0 y.

D - diameter [rmm]




Advanced Training - Parameters

* Finally the following document is obtained in ODA after an automatic calculation:

|| gle Edit View sewp Help

=]

=== =R =T

Document

EE|

= @ Standaard
N Cl Node (Knopen)
Project sestrigs ] Load cases (Belastin
] combinations (Comi
E Parameters
= Internal forces on m
{3 Deformations on me
AR B
Description Standaard
Ermbed docu o
Loanguage  Dutch (Neth =
Ficgos s, |Let &
Headertempl.. | default = |
Editheaterts... [l
Title page tem... ** no tempal_~ |
Editfitle page t. |
Footertemplate defaut  ~|
Edit footer tem e
Firstpage nu.. 1
First chaptern... 1
Chapters num... Al |
Chapters capti. Al |
Refresh of document S>>
Refresh of pictures rrr
Load sefiings 5=,
Save seftings rr>
Save template 5SS

Calculation done

Note:

S | E0 W T defaurt - @ - 8P
Project
THHTTTHNN (o derdeet
NEMETSCHEK o, -
Scia Auteur
1. Knoop
Naam | Coordinaat X ‘ Coordinaat Y ‘ CoordinaatZ Naam | Coordinaat X ‘ Coordinaat Y ‘ CoordinaatZ
[m] ] [m] [m] ] ]
K | 0,000 0,000 o0 K &,000 | 0,000] 0,000
2. Belastinggevallen
Maam | Omschrijving ‘ Actie type | Lastgroep | Belastingtype Spec ‘Riclm’ng Duur ‘ ‘Master’
BG1 P ] Eigen gewicht ‘ ‘rz
BG2  |Linlast Variabel  |LG2 Statisch Standaard Kort Geen
3. Combinaties
Naam Type ‘Hel&ﬁllggwalleu Coifl,
H
UGT  |EN-UGT Fundamenteel | a1 100
BG2 - Lijnlast 1,00
GGT  |EN-UGT Fundamenteel | 5G1 100
BG2 - Lijnlast 1,00
4. Parameters
Naam_| Tupe | Evaluate | 0 | Waarde | Eenheid
Doorshede lengte | ¥Waarde diameter 2000 ‘mm
t Doorsnede lengte | Waarde dikte 30 mm
5. Interne krachten in staaf
Lineaire berekening, Extreern : Globaal, Systeem : Hoofd
Selectie : Alle
Cornbinaties : UGT
BG|S|az|f|\:§‘dx‘N|Vy‘Vz‘Mx‘My|Mz
! I [l | (G| N | BN Gkl | (KNl | [kb]
T | Reacly [nl]
<Back

So, it's not possible to adapt the geometry on the graphical screen like we do in SCIA

Engineer.

In ODA, only the inserted parameters can be adapted.
It's also not possible to add new tables in the document. ODA uses the document from

the template.

| Mext>
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Batch optimizer

The batch optimizer is a special function of ODA. First of all a parametric project is
made in SCIA Engineer.

Then an input and output file has to be made in XML. Subsequently they can be read in
ODA.

A begin and end value of the parameter can be filled in and an iteration step to be
performed. The results are the values of the desired output parameter.

Example:

A beam on two supports is created in SCIA Engineer. The line load is parameterized.
In ODA the moment My will be asked for a certain range of this parameter.




Advanced Training - Parameters

Project data: - Construction type: Frame XYZ

Input support:

Method

- Project level advanced

== todel data
- Z% Suppart
& innode

The line load is parameterized with a begin value of -5 kN/m

Subsequently go to ‘Tools > XML 10 document’ and export an input and output file:

Input file:
O =
DOC-Standerd v|.] Ba|| |50 @[T deun | 0B defaute -
= 49 Standaard
[ Parameters 1. Parameters
Name | UniquelD Type | Evaluation | Use range |
P_ {1C5AFDAB-6476-45C8-AF12-2F77DDC47BC2} | Line load | Value false }
Standaard
Embeddocu.. O
Language English (Umj
Pictures align.. Left R
O =
BEE-Sandaard il BS | |50 Wl T default ~ [\ |FR default v
= 4 Standaard L1
[ parameters 1iParameters
me | UniquelD | Type | Evaluation | Use range |
false
Document Expt @
File 2| DiScinEsa PTiProjecten PertheorieParameters\Projects parametersiinaut batch opbanl |+ |
Type <
eeeon = 2] #ML file {usable for data exchange with other systems) b
Embed docu.. O L
Language Enl v
Pictures align...  Le Open atter export
Headerternpl.. de Ummdg
Editheaderte... [ Description
Title page tem...
Edittitlie page t
Footer template de
Editfocter tem...
Firstpage nu.. 1
Firstchaptern... 1
Chapters num... Al
Chapters capti.. All| | ]
English {United States) [1252] [ Epont | [ concel
Fefresh of docum i
Load settings e
Save seflings e
Save template === L] Maam < *|
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Output file:
= -
DOCStendaard ¥ B&|| |50 kb7 et [~ | @ detaut [v
= 4 standaard -
= interndl forces on mq | 1. Inte rne krachten in staaf
Table
BG | Staaf css dx N | Vy Vz Mx My Mz
£ >
BG1 |S1 CS1-RECT |1e-006 |0 2811252734 0 -5051275 0
BG1 |51 CS1-RECT |9 0 -1688747266 |0 0
Jam Interne krach
T oo, || BGT | S1 CS1-RECT |54 |0 1112527344 |0 |28394.90039 |0
Visihle B yes
Preferone pa.. O
Selection All =
Typeofloads  Load cases 7|
Load cases BG1 =
Filter No B
Structure Initial =
Yalues by B
System Principal  ~|
Extreme Global B
Section All i
O : =
DOC-Standeard YlollmEEas| |50 W7 detaun | B[ deault v
= 4 Standaard 1
O parameters Parameters
Name | UniquelD | Type | Evaluation | Use range |
false
Document Export @
File || DiScinEsa PT\Projecten Pertheorie Parameters\Projects parameters\outaut_batch aptanl | |
Type i
Doction = = =ML file (usahle for data exchange with other systems) b
Embeddocu.. O L
Language Enl v
Pictures align...  Le Open after export
Headerternpl.. de Ummdg
Editheaderte... [ Description
Title page tem...
Edittitlie page t
Footer template de
Editfocter tem...
Firstpage nu.. 1
Firstchaptern... 1
Chapters num... Al
Chapters capt.. All| | ]
English {United States) [1252] [ Epont | [ concel
Fefresh of docum i
Load settings e
Save seflings e
Save template === L] Maam < *|
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This project can now be opened in ODA. For this, you choose the option ‘Batch

optimizer’.

Choose type of new project

Batch optimizer

= E+= == B
=3 == == i
Concrete Bearn - Concrete Bearm - Concrete Slak MixBearn Farametric
Standard Achvanced Froject

e
R

Zeman

Mame

Cancel |

Subsequently a dialog box appears in which the Esa project and both XML files have

to be collected:

Project settings

—Files

Scia Engineer project file

D\Zcia Esa PTyProjecten Per theorie\FParametersi\Projects param| =

Farameters source IFrDm userxhL file - |

Input parameters

XML IO Document I LI

Farameters file

D\Scia.Esa FTyFrojecten Fer theariehFarameters\Frojects param =

Qutput parameters

ML 10 Document I LI

Farameters file

ID:\SCiaEsa FTyFrojecten Per thearieyFarameters\Projects param| =

Twpe of analysis ILinear i I

[ Autodesign calculation

[+ Fackfiles with project
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e If an optimisation was used in the Esa project, it can be taken into account here by
selecting the option ‘optimisation calculation’.

You can ask for the results for a number of values of the parameter. Here the parameter ‘line
load on member’ can be used. A begin value of -5 and an end value of -10 can be taken with
an iteration step 1.

W scia Engineer Template - NONAME

|| Bl Edit View Setup Help
DE@| 2 (82| mE

Setup parameters
Commands x|

i
Project settings

Setup parameters
=l
Setup Parameters List
Output parameters
Constant parameters

Formula

Results

| Fle Edit View setup Help

Name Unit Startvalue

[ [ [
kN/m -20 -5

End value I Step |
z
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The values of the output XML file that have to be evaluated, can be marked. The values
for My_max and My_min are checked.

File Edit View Setup Help
EECIEEEREE
Output parameters
Commands ﬂﬂ :
Deep refresh
: : [ Class i Esa Name Name Evaluatic
Project settings T | Interne krachten i staaf e ox_max o
| a2 d d_min [m}
a8 I~ [N _max O
Setup parameters -
4 [} M_rmin m]
5 My Wy_miax 8]
Setup Paramet: & Wy Wye_min 1
7 Wz Wz_max m]
R Wz “Wz_min jm]
Output parameters q I Wb _manx O
0 M | Mb_min O
Iy Iy _rmiax i)
Constant parameters. [ My_rmin =
Mz hdz_max o
i Mz | Mz_min =D
Formula
Results
Ready. <Back | Nex>

Possibly constant values and formulae can be inserted. They will be taken into account
in the result table.

Finally you can go to the results, where a calculation is performed for the various line
loads. This is performed in various iteration steps, which are executed independently
from each other.

The result is as follows:

| File Edit View Setup Help
=l oc02||mel

sport ress el
- Fee e 5] 2|
Project settings T
. P_ [Kijm] My_rna [khm] My:_min [kNm]

Setup parameters S8l 2500 agn 202,05
B 2 |18 102.22 8186
Setup Parameters List LIB-1.00 o086 8884
4 |-14.00 7451 -141.44
81200 BB1E -121.23
Output parameters B |00 570 ELIEE
7 | ] 8092
8 |-6.00 3407 -B0.62

Constant parameters

=

Formula

1 Results |24 Analyzer
Ready <Back | Ned>
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Example 14: User blocks & ProjectTemplates

User blocks

SCIA Engineer enables the user to make a library of his/her projects that are used over
and over again. These projects may be at any time included into a newly created project
or appended to an earlier created and currently edited project.

The projects in this user-created library are called User blocks and the library is called
User block library.

We take example 8 again: Steel frame.esa

Save as user block:
‘File > Save as ‘ and then save in the file userblocks.

You can find it in:

Options ﬁ

Environment | Templates Directaries |Other | Protedionl Code |

— Program directories

Show directories for:

IUserblocinbraries LI

Directaries i + &
CADocuments and Settingshastrid. SCIA-ONLINE WMy Documents\ESASIYuserbloc...

—Motice
'j These settings cannot be edited while a projectis opened.
.

oK I Cancel Help

« Make a new project, e.g. in general XYZ
e Open the Structure menu :

=% Advanced Input
5 cks

f;E] Lser hlocks
redefined shapes
& Import project (esa file)
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The following dialog boxes appear:

User blocks ﬁ
-0 Userlibrary "‘ff“r
steel frame
CADocuments and SettingsiAstrid. SCIA-ONLINE My Documents\ESAGBDuserblockssteel
rame ESA
OK I Cancel
[ Parameters of block ﬁ

geo spant | Raamwearkafstand | werbindingen |

H1 -Heigth 1 [m]

[5.00

H2Z - Heigth 2 [m]
L-Length [rm]

3,00
10,00

- Sample picture

H

Refresh il il

| I

[ o |

Cancel

Apply

|
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P

Import user block ﬁ
Setup \Material]
Import type Structure with all other data |
Import structure into: | Current layer |
Load cases Add black library item |~
Cross-Sections Add block library item 5l
Bolt assembly Add block library item il
Load groups Add block library item il
Others Add block library item |

* Insert another user block
- withNS=3
- frame distance = 8 and NS =4
- lengthL=15and NS =3

¢ Here you can get the following example:
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Project templates

In practice it may quite often happen that some elements are used in every project. For
example, material types, cross-sections, predefined loads, and even parts of a structure may
be the same in various projects. Therefore, it would be efficient, if the user could store the
repetitious elements aside and load them quickly into every new project.

In SCIA Engineer this may be achieved via templates. Generally speaking, a template is an
ordinary project that holds required information and is saved in a special way.

Let's take example 8 again: Steel frame.esa

Save as template: ‘File > Save as' in the folder:

-

Options

Enviranment | Templates Ditectatias lOther l Prntediun] Code l

Frogram directaries

Show directones for:

|User'|'emp|ates

Directaries

[

* @

MNaotice

'

ChDocuments and SetingsiAstrid SCIA-OMNLINEWWy Docurments\ESABDtemplate. .

'j These settings cannct be edited while a praject is opened.
L

o |

Cancel Help
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Close example 8 and open a new project. Go to the tab ‘User templates’.

Select New Project

MNew Project Usertemplates |

=1 Templates i i
|20 Connect r r
|21 Steel beam with oDaA Steel frame
practical rei...

Ch\Documents and SettingsiAstid SCIA-ONLINE\My Documents\ESASIemplates\Steel frame ESA

Cancel

[ o |

*  When opening this template, also here a dialog box appears with possible
parameters that can be adjusted:
DPr‘nje'ct

geo spant I Faamwerkafstand verbindmgeni Project settings l

[ 5.00

H1 - Heigih 1 [m]
H2 - Heigth 2 [m]
L-Length [m]

300
1000

—Sample picture

H

Refresh

El
- v
bl I
AT FS
y ) Fa

T = - =

‘ | e
L - 2

L] _] A
ok | cenel
24|
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General parameterizing

If you doubt if a certain property can be parameterized or not, it is advisable to create as
many types of parameters as possible that can possibly be the required parameter.

Type of parameters:

Parameter types
Nothing The parameter is not used.
Integer The parameter is used as an integer
Coefficient The parameter is used as coefficient.
Length The parameter is used for definition of length in the model
Force The parameter is used for definition of size of farce load.
Moment The pararmeter is used for definition of size of moment load
Line load The parameter is used for definition of size of line load.
Surface load The parameter is used for definition of size of surface load.
Mass The parameter is used for definition of size of masses.
Line mass The parameter is used for definition of size of line masses.
Surface mass The pararmeter is used for definition of size of surface masses.
Cross-section length The parameter is used for definition of length at cross-sections.
Angle The parameter is used for definition of angles
Relative The pararmeter is used for definition of relative values
Cross-section rolled The parameter is used for definition of cross-sections.
Library This parameter type can be used with ary "library" itemn, 2. any item that is selected from one of ESA PT's internal databases, such as

materials, cross-sections, subsail, reinforcement pattern, etc

Combination factor Combination factors for load cases inserted into @ combination.
Relative humidity applicable in the calculation of long term losses in prestress
Time (history) Time of individual construnction stages on time-line
Stress (i) Stress in concrete that can be defined in measured values when the Time Dependant Analysis is performed or

{il) the initial stress of the strands for a strand pattern
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Possible formulae:

+ Adds the given numbers / parameters

- Subtracts the given numbers { parameters

Multiplies the given numbers / parameters

I Divides the given numbers f parameters

1 Modula — gives the remainder after division of two numbers
Fir Faises the given number to a given pawer

() Putting individual members of the expression may change the prigrity of evaluation.
sin(x) Calculates the sine of parameter x

cos(x) Calculates the cosine of parameter x

tan(x) Calculates the tangent of parameter x

ta(x)

aresin(x) Calculates the arcsine of parameter x

asin(x)

arccos(x) Calculates the arccosine of parameter x

acos(x)

arctan(x) Calculates the arctangent of parameter x

arectg(x)

atan(x)

atg(x)

In(x) Calculates the natural lagarithm of =,

log(x) Calculates \ng(x)

exp(x) Calculates the exponential e to the x-th power

sign(x) Returns the sign of parameter x. Returns +1 for positive argument. Returns -1 for negative argument.
sgn(x)

sqrt(x) Calculates the positive sguare roat of parameter x
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Possible operators in SCIA Engineer:

¥ "+" ADD:

¥ " SUB:;

¥ """ MUL;

¥ "\\" MOD;

¥ " DIV;

» N PO

¥ "<" LESS;

¥ "<=" LESS_OR_EQUAL;
¥ "==" EQUAL;

¥ "<>" NOT _EOUAL:;

¥ "»=" EQUAL_OR_BIGGER;
¥ "»" BIGGER;

¥ "&&" AND;

¥ '] OR;

¥ "M XOR;

Example of a formula:

¥ (\_S==1)*HW+{\/_S==0)*{\W/-100])
I\ S=1 then H_BL=HW
I\ S=0 then H_BL=H\W/~100

e . [XEI

| Tyoe ! i
Description Hahe Bodochprofil
Evauation Eoomuis
Formula | W _S==Tj"HW+{W_S==T7{HW-100)
Valus [m]

Lse ranga o



